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check-amt-montreal

Checks the numbers of warnings reported by the AMT trains in the Montreal area.
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check-arp-no-change

Verify that a host MAC addresse doesn’t change
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check-asterisk-cdr-status

Shinken plugin from SFL. Check asterisk sql cdr
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check-aws-sqs-activity

Checks the activity of AWS’s simple queue service.





          

      

      

    


    
         Copyright 2014, Savoir-Faire Linux.
      Created using Sphinx 1.3.5.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	sfl-shinken-plugins 0.1 documentation 

          	Plugins 
 
      

    


    
      
          
            
  
check-aws-sqs-queue-size

Checks the size of an AWS sqs queue
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check-bixi-montreal

Checks empty or full Bixi (public bike service) stations, in Montreal.
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check-brother-toner-level

Shinken plugin from SFL. Check toner levels of Brother printer by http
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check-carp-by-ssh

Shinken plugin from SFL. Check carp status on Soekris using ssh
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check-ceilometer

Shinken plugin from SFL. A Nagios plug-in to use OpenStack Ceilometer API for metering
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check-cpu

Shinken plugin from SFL. check CPU usage
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check-emergency-rooms-quebec

Checks the occupation of stretchers in various hospitals in Quebec.

To find pre-defined hospitals configuration, please check
[Quebec-monitoring](https://github.com/matthieucan/quebec-monitoring/blob/master/scripts/hospitals.py)
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check-environment-canada

Checks various environment metrics in Canada.
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check-fake

Shinken plugin from SFL. Fake plugin
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check-graphite-api

Shinken plugin from SFL.

This plugin is made to ensure data freshness into Graphite.
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check-http2

Checks HTTP sites, and doesn’t timeout like good’old check_http.





          

      

      

    


    
         Copyright 2014, Savoir-Faire Linux.
      Created using Sphinx 1.3.5.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	sfl-shinken-plugins 0.1 documentation 

          	Plugins 
 
      

    


    
      
          
            
  
check-hydro-quebec

Get the number of service problems
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check-json-by-ec2-tags

Runs check-json on all AWS ec2 instances with a particular tag.
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check-libvirt-stats

Shinken plugin from SFL. Guest and host statistics from libvirt API
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check-linux-bandwidth

check usage bandwidth per month
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check-linux-traffic

Shinken plugin from SFL. Check traffic on linux hosts using /proc/net/dev
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check-mem

Shinken plugin from SFL. Plugin to check memory usage
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check-mpt-status

Shinken plugin from SFL. Check mpt HW RAID controllers status





          

      

      

    


    
         Copyright 2014, Savoir-Faire Linux.
      Created using Sphinx 1.3.5.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	sfl-shinken-plugins 0.1 documentation 

          	Plugins 
 
      

    


    
      
          
            
  
check-openbsd-sysstats-byssh

Shinken plugin from SFL. Check OpenBSD system stats using ssh





          

      

      

    


    
         Copyright 2014, Savoir-Faire Linux.
      Created using Sphinx 1.3.5.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	sfl-shinken-plugins 0.1 documentation 

          	Plugins 
 
      

    


    
      
          
            
  
check-openerp

Shinken plugin from SFL. Check OpenERP using a web scenario
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check-poller2livestatus

Shinken plugin from SFL. Check Shinken from poller to livestatus module
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check-postgresql-lag

check postgresql streaming latency
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check-printer-hp-2600n

Shinken plugin from SFL. Check toner level from a hp 2600n printer
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check-quebecrencontrescom

Checks number of lonely hearts on quebecrencontres.com.
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check-rancid

Shinken plugin from SFL.
Check various things from a rancid repo depending on the mode.
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check-reactionner-health

Shinken plugin from SFL. Pseudo crontab to check if a file is edited by shinken reactionner
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check-redis

check redis data base
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check-reseaucontactcom

Checks number of lonely hearts on reseaucontact.com.
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check-samba

Shinken plugin from SFL. Samba server check
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check-selenium

Web scenario tests using Selenium


Firefox Selenium IDE extention


Install Selenium IDE

You need to install Firefox Selenium IDE extension. You can get it HERE

When you got this file, you have to install it in Firefox:

Click on Tools -> Add-ons


[image: ../../_images/1.png]
Go to Add-ons page



On Add-ons page, select Install Add-on from file...*


[image: ../../_images/2.png]
Install Add-on from file...



Select selenium-ide-2.8.0.xpi file on your system


[image: ../../_images/3.png]
selenium-ide-2.8.0.xpi file



Click on Install Now to install extensions


[image: ../../_images/4.png]
Click on Install Now






Configuration

You have to change the default configuration of your Firefox Selenium IDE extention.

To open Selenium IDE window, click on Tools -> Selenium IDE


[image: ../../_images/5.png]
Open Selenium IDE window



In Selenium IDE window, open settings by clicking on Options > Options


[image: ../../_images/14.png]
Menu Options



Then go on Locator Builders tab


[image: ../../_images/15.png]
Locators list




Note

You have to put the link item to the bottom of the list






How to create a new scenario

This is an example how to create a new web scenario.

This scenario runs on http://savoirfairelinux.com:


	sdg

	sdg




	First, you have to go to the web page where the web scenario starts. In this case, it’s http://savoirfairelinux.

	Open Selenium IDE window; Click on Tools -> Selenium IDE




[image: ../../_images/5.png]
Open Selenium IDE window




	When the Selenium IDE window is open, please ensure that record button is pushed




[image: ../../_images/6.png]
Record button




	Now you can start your scenario.
The first thing to do is to check if the first page is the good one.
So, select any text in this page, right-click on it and select
WaitForText ....




[image: ../../_images/7.png]
WaitForText .........




	In Selenium IDE window, you can check the result of your action.
A new line was created with WaitForText ....




[image: ../../_images/8.png]
New line WaitForText ....




	Now you can continue your scenario.
You can now click on Contact Us and wait th page is completely loaded




[image: ../../_images/9.png]
Contact Us page




	As on the first page, select any text in this page,
right-click on it and select WaitForText ....




[image: ../../_images/10.png]
WaitForText .........




	Check the output on Selenium IDE window




[image: ../../_images/11.png]
New lines in Selenium IDE window



Now, you can continue your scenario following this example.


Warning

Please read Recommendations




Save scenario

When you have finished your scenario, you can save it.
This is highly recommended because, this is the only
way to edit the scenario in the future ...

To save the sceario, click on File > Save test Case


[image: ../../_images/12.png]
Save scenario






Export scenario to Python file

In order to use the scenario with the check_selenium plugin, you need to export
the scenario to a Python file.

Click on File > Export Test Case As... > Python 2 /unitest / WebDriver


[image: ../../_images/13.png]
Export scenario




Warning

Use only LOWER CASE letters (a-z) when you export a scenario !!!!!




Note

This file will be used by the check_selenium plugin








Recommendations


Warning

Be carefull about site language:


	When you record the web scenario, you use YOUR Firefox profile with YOUR preferences

	When the web scenerio is played, selenium use a “vanilla” Firefox profile.



So, default site language could be FR/ES/DE with YOUR Firefox but it could EN with “vanilla” Firefox profile.




Danger

Also, when you want to wait a text, choose preferally:


	Short text

	One line text

	Not full uppercase text










How to use the plugin


Requirements

This plugin need:


	selenium==2.44.0

	shinkenplugins==0.1.6

	xvfbwrapper==0.2.4



You can install it, with:

pip install -r requirements.txt








How to use the Plugin

Show help

$ ./check_selenium -h





Launch scenario

$ ./check_selenium -S scenarios -s savoirfairelinuxcom
OK: Scenario execution time: 4.57 seconds





If you get an error/bug in your scenario with the plugin, you
can launch it in debug mode. In debug mode, Firefox will be launched
on your display. You will be able to see what Firefox does.

$ ./check_selenium -S scenarios -s savoirfairelinuxcom -d
OK: Scenario execution time: 4.57 seconds





You can also set the size of your Firefox use -W and -H options. This is usefull for scenario on mobile web site.

$ ./check_selenium -S scenarios -s savoirfairelinuxcom -W 400 -H 800
OK: Scenario execution time: 4.57 seconds





Here, the example of command which can be used in your shinken configuration.
Don’t forget to add -f option to get perfdata and get graph.

$ $USER1$/check_selenium -S $SCENARIOS_FOLDER$ -s $ARG1$ -w $ARG2$ -c $ARG3$ -f
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check-site-health

Shinken plugin from SFL. Browse web site to find broken links
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check-smtp-success-ratio

Shinken plugin from SFL. Given a maillog, checks for a good ratio of sent versus total emails.
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check-snmp-interface

This plugin check interface traffic using SNMP
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check-spa2102

Shinken plugin from SFL. Check Linksys SPA-2102 status
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check-stm-metro-montreal

Checks the current state of the metro in Montreal.
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check_test

TESTTEST
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check-tripplite-ups

Shinken plugin from SFL. Check Tripplite UPSs
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check-wanpipe

Shinken plugin from SFL. Check channels in error with wanpipe
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check-x224

Checks an x224 (RDP) service.
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Packs



	sfl-generic-carbon-tcp
	Dependencies

	Installation

	How to use it





	sfl-generic-dhcp
	Dependencies

	Installation

	How to use it





	sfl-generic-dns
	Dependencies

	Installation

	How to use it





	sfl-generic-graphite-http
	Dependencies

	Installation

	How to use it





	sfl-generic-host
	Dependencies

	Installation

	How to use it





	sfl-generic-ldap
	Dependencies

	Installation

	How to use it





	sfl-generic-mongodb
	Dependencies

	Installation

	How to use it





	sfl-generic-multisite-http
	Dependencies

	Installation

	How to use it





	sfl-generic-radius
	Dependencies

	Installation

	How to use it





	sfl-generic-repodeb-http
	Dependencies

	Installation

	How to use it





	sfl-generic-saltmaster-tcp
	Dependencies

	Installation

	How to use it





	sfl-generic-smb
	Dependencies

	Installation

	How to use it





	sfl-generic-splunk-http
	Dependencies

	Installation

	How to use it





	sfl-generic-ssh
	Dependencies

	Installation

	How to use it





	sfl-linux-ntp-collectd
	Dependencies

	Installation

	How to use it





	sfl-linux-radius-collectd
	Dependencies

	Installation

	How to use it





	sfl-linux-saltmaster-collectd
	Dependencies

	Installation

	How to use it





	sfl-linux-saltminion-collectd
	Dependencies

	Installation

	How to use it





	sfl-linux-system-collectd
	Dependencies

	Installation

	How to use it





	sfl-vmware-system-https
	Dependencies

	Installation

	How to use it





	sfl-windows-ad-collectd
	Dependencies

	Installation

	How to use it





	sfl-windows-mssql
	Dpendencies

	Installation

	How to use it





	sfl-windows-rdp
	Dependencies

	Installation

	How to use it





	sfl-windows-sophos-collectd
	Dependencies

	Installation

	How to use it





	sfl-windows-sophos-mssql
	Dependencies

	Installation

	How to use it





	sfl-windows-system-collectd
	Dependencies

	Installation

	How to use it
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sfl-generic-carbon-tcp


Dependencies


Shinken Modules




Plugins


check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http





or

/usr/lib64/nagios/plugins/check_http










Network

This pack will create services which need the following protocol :


	TCP 80 and/or 443 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_CARBON_WARN





	type:	Integer


	description:	Warning threshold








_CARBON_CRIT





	type:	Integer


	description:	Critical threshold
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sfl-generic-dhcp


Dependencies


Shinken Modules




Plugins


check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp





or

/usr/lib64/nagios/plugins/check_dhcp





The plugin permissions should be:

-rwsr-xr-x root root check_dhcp





If not, you can fix it with


sudo chown root: /usr/lib/nagios/plugins/check_dhcp
sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp







Network

This pack will create services which need the following protocol :


	UDP 67 and 68 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition




Triggers

No trigger used with this packs
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sfl-generic-dns


Dependencies


Shinken Modules




Plugins


check_dns

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dns





or

/usr/lib64/nagios/plugins/check_dns










Network

This pack will create services which need the following protocol :


	UDP 53 and/or TCP 53 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings


_DNSHOSTNAME





	type:	string


	description:	Hostname to resolve








_DNSEXPECTEDRESULT





	type:	string


	description:	Address expected returned by the DNS server








_DNSWARN





	type:	Integer


	description:	Warning threshold








_DNSCRIT





	type:	Integer


	description:	Critical threshold










Triggers

No trigger used with this pack









          

      

      

    


    
         Copyright 2014, Savoir-Faire Linux.
      Created using Sphinx 1.3.5.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	sfl-shinken-plugins 0.1 documentation 

          	Packs 
 
      

    


    
      
          
            
  
sfl-generic-graphite-http


Dependencies


Shinken Modules




Plugins


check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http





or

/usr/lib64/nagios/plugins/check_http










Network

This pack will create services which need the following protocol :


	TCP 80 and 443 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_GRAPHITEURL





	type:	string


	description:	The Graphite path. Default: /








_GRAPHITEWARN





	type:	Integer


	description:	Warning threshold. Default: 3








_GRAPHITECRIT





	type:	Integer


	description:	Critical threshold. Default: 5
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sfl-generic-host


Dependencies


Shinken Modules




Plugins


check_ping

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ping





or

/usr/lib64/nagios/plugins/check_ping










Network

This pack will create services which need the following protocol :


	ICMP








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_LOAD_WARN





	type:	3 comma-separated integer


	description:	Load warning threshold (ie: 7,6,5)








_LOAD_CRIT





	type:	3 comma-separated integer”,


	description:	Load critical threshold (ie: 10,9,8)”








_STORAGE_USED_WARN





	type:	percent


	description:	Warning level for used storage space








_STORAGE_USED_CRIT





	type:	percent


	description:	Critical level for used storage space








_PROCESS_CRON_MIN_WARN





	type:	integer


	description:	Min number of cron processs, warning threshold








_PROCESS_RSYSLOGD_MIN_WARN





	type:	integer


	description:	Min number of rsyslog processs, warning threshold








_PROCESS_RSYSLOGD_MIN_CRIT





	type:	integer


	description:	Min number of rsyslog processs, critical threshold








_PROCESS_OSSEC_MIN_WARN





	type:	integer


	description:	Min number of ossec processs, warning threshold








_PROCESS_OSSEC_MIN_CRIT





	type:	integer


	description:	Min number of ossec processs, critical threshold










Triggers

This is the list of triggers used in the pack :


	collectd_cpu.trig

	collectd_df.trig

	collectd_disk.trig

	collectd_interface.trig

	collectd_load.trig

	collectd_memory.trig

	collectd_processes.trig

	collectd_swap.trig

	collectd_users.trig
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sfl-generic-ldap


Dependencies


Shinken Modules




Plugins


check_ldap

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ldap





or

/usr/lib64/nagios/plugins/check_ldap








check_ldaps

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ldaps





or

/usr/lib64/nagios/plugins/check_ldaps








check_tcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_tcp





or

/usr/lib64/nagios/plugins/check_tcp










Network

This pack will create services which need the following protocol :


	TCP 636 from Poller to monitored client with SSL

	TCP 389 from Poller to monitored client without SSL








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Templates




sfl-generic-ldap

Use this template to monitoring a standard LDAP server.




sfl-generic-ldap3

Use this template to monitoring a LDAP3 server.




sfl-generic-ldaps

Use this template to monitoring a LDAPS server.




Settings

This is the list of settings which can be redefined in the host definition


_LDAPBASE





	type:	string


	description:	The read snmp community allowed on the linux server








_DOMAIN





	type:	string


	description:	The read snmp community allowed on the linux server








_DOMAINUSERSHORT





	type:	string


	description:	Short name (without the domain) of the user to query the server. Should have rights on the WMI tables for reading








_DOMAINUSER





	type:	string


	description:	Full name of the user to query. Is by default DOMAIN\USERSHORT








_DOMAINPASSWORD





	type:	string


	description:	Password for the user that will launch the query










Triggers
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sfl-generic-mongodb


Dependencies


Shinken Modules




Plugins

This pack will create services which need the following plugin :

https://github.com/mzupan/nagios-plugin-mongodb/blob/master/check_mongodb.py

and it here:

/usr/lib/nagios/plugins/check_mongodb.py




Network

This pack will create services which need the following protocol :


	TCP 27017 to connect with MongoDB

	SSL








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_MONGO_PORT





	type:	integer


	description:	port of Mongodb


	default:	27017








_MONGO_CONNECTION_WARNING





	type:	integer


	description:	warning threshold for the connection time to the server


	default:	2








_MONGO_CONNECTION_CRITICAL





	type:	integer


	description:	critical threshold for the connection time to the server


	default:	4








_MONGO_PERCENTAGE_CONNECTION_WARNING





	type:	integer


	description:	warning threshold for the connection pool


	defaut:	70








_MONGO_PERCENTAGE_CONNECTION_CRITICAL





	type:	integer


	description:	critical threshold for the connection pool


	defaut:	80








_MONGO_REPLICATION_LAG_WARNING





	type:	integer


	description:	warninig threshold for the lag : second


	defaut:	15








_MONGO_REPLICATION_LAG_CRITICAL





	type:	integer


	description:	critical threshold for the lag : second


	defaut:	30








_MONGO_REPLICATION_LAG_PERCENT_WARNING





	type:	integer


	description:	warning threshold for the lag


	defaut:	50








_MONGO_REPLICATION_LAG_PERCENT_CRITICAL





	type:	integer


	description:	critical threshold for the lag


	defaut:	75








_MONGO_MEMORY_WARNING





	type:	integer


	description:	warning threshold for usage of ram by MongoDB : gig


	defaut:	20








_MONGO_MEMORY_CRITICAL





	type:	integer


	description:	critical threshold for usage of ram by MongoDB : gig


	defaut:	28








_MONGO_MEMORY_MAPPED_WARNING





	type:	integer


	description:	warning threshold for memory mapped : gig


	defaut:	20








_MONGO_MEMORY_MAPPED_CRITICAL





	type:	integer


	description:	critical threshold for memory mapped : gig


	defaut:	28








_MONGO_LOCK_WARNING





	type:	integer


	description:	warning threshold for the lock time : %


	defaut:	5








_MONGO_LOCK_CRITICAL





	type:	integer


	description:	critical threshold for the lock time : %


	defaut:	10








_MONGO_FLUSHING_WARNING





	type:	integer


	description:	warning threshold for the average flush time : ms


	defaut:	100








_MONGO_FLUSHING_CRITICAL





	type:	integer


	description:	critical threshold for the average flush time : ms


	defaut:	200








_MONGO_LAST_FLUSH_WARNING





	type:	integer


	description:	warning threshold for the last flush time : ms


	defaut:	200








_MONGO_LAST_FLUSH_CRITICAL





	type:	integer


	description:	critical threshold for the last flush time : ms


	defaut:	400








_MONGO_INDEX_MISS_RATIO_WARNING





	type:	float


	description:	warning threshold for the ratio of index hits to misses


	defaut:	.005








_MONGO_INDEX_MISS_RATIO_CRITICAL





	type:	float


	description:	critical threshold for the ratio of index hits to misses


	defaut:	.01








_MONGO_QUERIES_PER_SECOND_WARNING





	type:	integer


	description:	warning threshold for the count of queries


	defaut:	200








_MONGO_QUERIES_PER_SECOND_CRITICAL





	type:	integer


	description:	critical threshold for the count of queries


	defaut:	150








_MONGO_CONNECT_PRIMARY_WARNING





	type:	integer


	description:	warning threshold for the connection to the primary server of current replicaset : second


	defaut:	2








_MONGO_CONNECT_PRIMARY_CRITICAL





	type:	integer


	description:	critical threshold for the connection to the primary server of current replicaset : second


	defaut:	4
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sfl-generic-multisite-http


Dependencies


Shinken Modules




Plugins


check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http





or

/usr/lib64/nagios/plugins/check_http










Network

This pack will create services which need the following protocol :


	TCP 80 and 443 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_MULTISITE_USER





	type:	string


	description:	The Multisite admin user login. Default: nagiosadmin








_MULTISITE_PASSWORD





	type:	string


	description:	The Multisite password admin login. Default: nagiosadmin








_MULTISITE_URL





	type:	string


	description:	The Multisite URL. Default: /check_mk








_MULTISITEWARN





	type:	Integer


	description:	Warning threshold. Default: 3








_MULTISITECRIT





	type:	Integer


	description:	Warning threshold. Default: 5
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sfl-generic-radius


Dependencies


Shinken Modules




Plugins


check_radius

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_radius





or

/usr/lib64/nagios/plugins/check_radius










Network

This pack will create services which need the following protocol :


	UDP : 1645 or 1812 from Poller to monitored client








Installation

Setup the /etc/radiusclient-ng/radiusclient.conf and /etc/radiusclient-ng/servers files properly.

At least, you have to add a line into the servers file for your radius server. Don’t forget to add the secret value!

Setup the /etc/raddb/clients.conf and /etc/raddb/users files properly.
The clients.conf file is used to add the poller IP and set the secret value.
The users file is used to define user/password credentials




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_RADIUSUSER





	type:	string


	description:	The Radius user login. Default: steve








_RADIUSPASSWORD





	type:	string


	description:	The Radius password login. Default: testing








_RADIUSFILE





	type:	string


	description:	The Radius config file path. Default: /etc/radiusclient-ng/radiusclient.conf








_RADIUSPORT





	type:	integer


	description:	The Radius udp port to query. Default: 1812
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sfl-generic-repodeb-http


Dependencies


Shinken Modules




Plugins


check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http





or

/usr/lib64/nagios/plugins/check_http










Network

This pack will create services which need the following protocol :


	UDP 80 and 443 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_URI_REPO





	type:	URI


	description:	The URI of the repo to check
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sfl-generic-saltmaster-tcp


Dependencies


Shinken Modules




Plugins


check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_tcp





or

/usr/lib64/nagios/plugins/check_tcp










Network

This pack will create services which need the following protocol :


	TCP 4505 Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_SALTMASTERPORT





	type:	integer


	description:	Salt master port. Default 4505








_TIME_WARN





	type:	double


	description:	Response time warning threshold. Default 1








_TIME_CRIT





	type:	double


	description:	Response time critical threshold. Default 2
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sfl-generic-smb


Dependencies


Shinken Modules




Plugins


check_samba

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_samba.py





or

/usr/lib64/nagios/plugins/check_samba.py










Network

This pack will create services which need the following protocol :


	TCP 139 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_SMB_USER





	type:	string


	description:	Samba user (Usally from AD). Default : $DOMAINUSERSHORT$








_SMB_PASSWORD





	type:	string


	description:	Samba password. Default : $DOMAINPASSWORD$








_SMB_DOMAIN





	type:	string


	description:	Samba domain. Default : $DOMAIN$








_SMB_SHARED_DIR





	type:	string


	description:	Samba shared directory. Default : Documents








_SMB_TIME_WARN





	type:	integer


	description:	Samba time warning threshold (s). Default 3








_SMB_TIME_CRIT





	type:	integer


	description:	Samba time critical threshold (s). Default 5








_SMB_TIMEOUT





	type:	integer


	description:	Samba time before timeout (s). Default 10
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sfl-generic-splunk-http


Dependencies


Shinken Modules




Plugins


check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp





or

/usr/lib64/nagios/plugins/check_dhcp





The plugin permissions should be:

-rwsr-xr-x root root check_dhcp





If not, you can fix it with


sudo chown root: /usr/lib/nagios/plugins/check_dhcp
sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp







Network

This pack will create services which need the following protocol :


	UDP 67 and 68 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_SPLUNKAPACHE





	type:	string


	description:	IP of apache server where splunk is. Used if splunk is behind a Apache auth








_SPLUNKURL





	type:	string


	description:	Splunk url on the webserver








_SPLUNKUSER





	type:	string


	description:	Splunk password








_SPLUNKPASSWORD





	type:	string


	description:	Splunk user password








_SPLUNKWARN





	type:	integer


	description:	Response time warning threshold








_SPLUNKCRIT





	type:	integer


	description:	Response time warning threshold
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sfl-generic-ssh


Dependencies


Shinken Modules




Plugins


check_ssh

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ssh





or

/usr/lib64/nagios/plugins/check_ssh










Network

This pack will create services which need the following protocol :


	TCP 22 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_SSHPORT





	type:	integer


	description:	SSH port. Usually 22
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sfl-linux-ntp-collectd


Dependencies


Shinken Modules

This pack will create services which need the following modules :


	Arbiter/Receiver : mod-collectd






Plugins

This pack will create services which need the following plugins :




Network

This pack will create services which need the following protocol :


	UDP 25826 from monitored client to the Arbiter/Receiver Collectd module








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_TIME_OFFSET_WARN





	type:	integer


	description:	offset warning threshold








_TIME_OFFSET_CRIT





	type:	integer


	description:	offset critical threshold








_TIME_DISPERSION_WARN





	type:	integer


	description:	dispersion warning threshold








_TIME_DISPERSION_CRIT





	type:	integer


	description:	dispersion critical threshold










Triggers

This is the list of triggers used in the pack :


	collectd_ntpd.trig
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sfl-linux-radius-collectd


Dependencies


Shinken Modules

This pack will create services which need the following modules :


	Arbiter/Receiver : mod-collectd



Here an example of a arbiter-collectd module config file:




Plugins

This pack will create services which need the following plugins :




Network

This pack will create services which need the following protocol :


	UDP 25826 from monitored client to the Arbiter/Receiver Collectd module






Collectd

Here an example of a collectd config file:






Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_PROCESS_RADIUS_MIN_WARN





	type:	integer


	description:	Min number of salt master processs, warning threshold








_PROCESS_RADIUS_MIN_CRIT





	type:	integer


	description:	Min number of salt master processs, critical threshold










Triggers

This is the list of triggers used in the pack :


	collectd_processes.trig
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sfl-linux-saltmaster-collectd


Dependencies


Shinken Modules

This pack will create services which need the following modules :


	Arbiter/Receiver : mod-collectd



Here an example of a arbiter-collectd module config file:




Plugins

This pack will create services which need the following plugins :




Network

This pack will create services which need the following protocol :


	UDP 25826 from monitored client to the Arbiter/Receiver Collectd module






Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>
    LogLevel info
    NotifyLevel WARNING
</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>
    Host "10.133.63.17"
    Host "10.133.63.19"
    Port 123
    ReverseLookups false
    IncludeUnitID true
</Plugin>

<Plugin df>
    IgnoreSelected false
    ReportByDevice false
    # Also including the reserved space
    ReportReserved true
    # Free/Used Inodes
    ReportInodes true
</Plugin>

<Plugin processes>
    Process "shinken-poller.py"
    Process "cron"
#    Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>
    Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>
    <Node "graphite_server_1">
        Host "10.133.63.13"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
    <Node "graphite_server_2">
        Host "10.133.63.14"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
</Plugin>

######################################################################
#  Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER










Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_PROCESS_SALTMASTER_MIN_WARN





	type:	integer


	description:	Min number of salt master processs, warning threshold








_PROCESS_SALTMASTER_MIN_CRIT





	type:	integer


	description:	Min number of salt master processs, critical threshold










Triggers

This is the list of triggers used in the pack :


	collectd_processes.trig
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sfl-linux-saltminion-collectd


Dependencies


Shinken Modules

This pack will create services which need the following modules :


	Arbiter/Receiver : mod-collectd



Here an example of a arbiter-collectd module config file:




Plugins

This pack will create services which need the following plugins :




Network

This pack will create services which need the following protocol :


	UDP 25826 from monitored client to the Arbiter/Receiver Collectd module






Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>
    LogLevel info
    NotifyLevel WARNING
</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>
    Host "10.133.63.17"
    Host "10.133.63.19"
    Port 123
    ReverseLookups false
    IncludeUnitID true
</Plugin>

<Plugin df>
    IgnoreSelected false
    ReportByDevice false
    # Also including the reserved space
    ReportReserved true
    # Free/Used Inodes
    ReportInodes true
</Plugin>

<Plugin processes>
    Process "shinken-poller.py"
    Process "cron"
#    Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>
    Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>
    <Node "graphite_server_1">
        Host "10.133.63.13"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
    <Node "graphite_server_2">
        Host "10.133.63.14"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
</Plugin>

######################################################################
#  Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER










Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_PROCESS_SALTMINION_MIN_WARN





	type:	integer


	description:	Min number of salt minion, warning threshold








_PROCESS_SALTMINION_MIN_CRIT





	type:	integer


	description:	Min number of salt minion, critical threshold










Triggers

This is the list of triggers used in the pack :


	collectd_processes.trig
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sfl-linux-system-collectd


Dependencies


Shinken Modules

This pack will create services which need the following modules :


	Arbiter/Receiver : mod-collectd



Here an example of a arbiter-collectd module config file:

## Module:      Collectd
## Loaded by:   Arbiter, Receiver
# Receive passive host and service results from a collectd daemon.
define module {
   module_name Collectd
   module_type collectd
#
#  Specify exact host (optional)
   host        0.0.0.0
   port        25826
#   port        25827
#   multicast   False
 grouped_collectd_plugins   cpu,df,disk,interface,ntpd
}

# this file is provided by (Minion ID): SHINKENFULL








Plugins

This pack will create services which need the following plugins :




Network

This pack will create services which need the following protocol :


	UDP 25826 from monitored client to the Arbiter/Receiver Collectd module






Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>
    LogLevel info
    NotifyLevel WARNING
</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>
    Host "10.133.63.17"
    Host "10.133.63.19"
    Port 123
    ReverseLookups false
    IncludeUnitID true
</Plugin>

<Plugin df>
    IgnoreSelected false
    ReportByDevice false
    # Also including the reserved space
    ReportReserved true
    # Free/Used Inodes
    ReportInodes true
</Plugin>

<Plugin processes>
    Process "shinken-poller.py"
    Process "cron"
#    Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>
    Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>
    <Node "graphite_server_1">
        Host "10.133.63.13"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
    <Node "graphite_server_2">
        Host "10.133.63.14"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
</Plugin>

######################################################################
#  Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER










Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_LOAD_WARN





	type:	3 comma-separated integer


	description:	Load warning threshold (ie: 7,6,5)








_LOAD_CRIT





	type:	3 comma-separated integer”,


	description:	Load critical threshold (ie: 10,9,8)”








_STORAGE_USED_WARN





	type:	percent


	description:	Warning level for used storage space








_STORAGE_USED_CRIT





	type:	percent


	description:	Critical level for used storage space








_PROCESS_CRON_MIN_WARN





	type:	integer


	description:	Min number of cron processs, warning threshold








_PROCESS_CRON_MIN_CRIT





	type:	integer


	description:	Min number of cron processs, critical threshold








_PROCESS_RSYSLOGD_MIN_WARN





	type:	integer


	description:	Min number of rsyslog processs, warning threshold








_PROCESS_RSYSLOGD_MIN_CRIT





	type:	integer


	description:	Min number of rsyslog processs, critical threshold








_PROCESS_OSSEC_MIN_WARN





	type:	integer


	description:	Min number of ossec processs, warning threshold








_PROCESS_OSSEC_MIN_CRIT





	type:	integer


	description:	Min number of ossec processs, critical threshold










Triggers

This is the list of triggers used in the pack :


	collectd_cpu.trig

	collectd_df.trig

	collectd_disk.trig

	collectd_interface.trig

	collectd_load.trig

	collectd_memory.trig

	collectd_processes.trig

	collectd_swap.trig

	collectd_users.trig
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sfl-vmware-system-https


Dependencies


Shinken Modules




Plugins


check_vmware_api.pl

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_vmware_api.pl





or


/usr/lib/64nagios/plugins/check_vmware_api.pl







Network

This pack will create services which need the following protocol :


	TCP 80 and 443 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_ESX_CPU_WARN





	type:	percent


	description:	Level for cpu usage








_ESX_CPU_CRIT





	type:	percent


	description:	Level for cpu usage








_ESX_MEM_WARN





	type:	percent


	description:	Level for ram usage








_ESX_MEM_CRIT





	type:	percent


	description:	Level for ram usage








_ESX_SWAP_WARN





	type:	percent


	description:	Level for swap usage








_ESX_SWAP_CRIT





	type:	percent


	description:	Level for swap usage
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sfl-windows-ad-collectd


Dependencies


Shinken Modules




Plugins


check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp





or

/usr/lib64/nagios/plugins/check_dhcp





The plugin permissions should be:

-rwsr-xr-x root root check_dhcp





If not, you can fix it with


sudo chown root: /usr/lib/nagios/plugins/check_dhcp
sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp







Network

This pack will create services which need the following protocol :


	UDP 67 and 68 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_LOAD_WARN





	type:	3 comma-separated integer


	description:	Load warning threshold (ie: 7,6,5)








_LOAD_CRIT





	type:	3 comma-separated integer”,


	description:	Load critical threshold (ie: 10,9,8)”








_STORAGE_USED_WARN





	type:	percent


	description:	Warning level for used storage space








_STORAGE_USED_CRIT





	type:	percent


	description:	Critical level for used storage space








_PROCESS_CRON_MIN_WARN





	type:	integer


	description:	Min number of cron processs, warning threshold








_PROCESS_RSYSLOGD_MIN_WARN





	type:	integer


	description:	Min number of rsyslog processs, warning threshold








_PROCESS_RSYSLOGD_MIN_CRIT





	type:	integer


	description:	Min number of rsyslog processs, critical threshold








_PROCESS_OSSEC_MIN_WARN





	type:	integer


	description:	Min number of ossec processs, warning threshold








_PROCESS_OSSEC_MIN_CRIT





	type:	integer


	description:	Min number of ossec processs, critical threshold










Triggers

This is the list of triggers used in the pack :


	collectd_cpu.trig

	collectd_df.trig

	collectd_disk.trig

	collectd_interface.trig

	collectd_load.trig

	collectd_memory.trig

	collectd_processes.trig

	collectd_swap.trig

	collectd_users.trig
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sfl-windows-mssql


Dpendencies


Shinken Modules




Plugins


check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_mssql_health





or

/usr/lib64/nagios/plugins/check_mssql_health





This plugin is available here : http://labs.consol.de/lang/en/nagios/check_mssql_health/






Network

This pack will create services which need the following protocol :


	TCP 1433 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_MSSQL_CONNECTION_CRIT





	type:	string


	description:	Time to connect to the server








_MSSQL_CONNECTION_WARN





	type:	string


	description:	Time to connect to the server








_MSSQL_CONNECTED_USERS_CRIT





	type:	string


	description:	Number of currently connected users








_MSSQL_CONNECTED_USERS_WARN





	type:	string


	description:	Number of currently connected users








_MSSQL_CPU_BUSY_CRIT





	type:	percent


	description:	Cpu busy in percent








_MSSQL_CPU_BUSY_WARN





	type:	percent


	description:	Cpu busy in percent








_MSSQL_IO_BUSY_CRIT





	type:	percent


	description:	IO busy in percent








_MSSQL_IO_BUSY_WARN





	type:	percent


	description:	IO busy in percent








_MSSQL_FULL_SCANS_CRIT





	type:	string


	description:	Full table scans per second








_MSSQL_FULL_SCANS_WARN





	type:	string


	description:	Full table scans per second








_MSSQL_TRANSACTIONS_CRIT





	type:	string


	description:	Transactions per second per database








_MSSQL_TRANSACTIONS_WARN





	type:	string


	description:	Transactions per second per database








_MSSQL_BATCH_REQUESTS_CRIT





	type:	string


	description:	Batch requests per second








_MSSQL_BATCH_REQUESTS_WARN





	type:	string


	description:	Batch requests per second










Triggers
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sfl-windows-rdp


Dependencies


Shinken Modules




Plugins


check_x224

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_x224





or

/usr/lib64/nagios/plugins/check_x224










Network

This pack will create services which need the following protocol :


	TCP 3389 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings
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sfl-windows-sophos-collectd


Dependencies


Shinken Modules

This pack will create services which need the following modules :


	Arbiter/Receiver : mod-collectd



Here an example of a arbiter-collectd module config file:

## Module:      Collectd
## Loaded by:   Arbiter, Receiver
# Receive passive host and service results from a collectd daemon.
define module {
   module_name Collectd
   module_type collectd
#
#  Specify exact host (optional)
   host        0.0.0.0
   port        25826
#   port        25827
#   multicast   False
 grouped_collectd_plugins   cpu,df,disk,interface,ntpd
}

# this file is provided by (Minion ID): SHINKENFULL








Plugins

This pack will create services which need the following plugins :




Network

This pack will create services which need the following protocol :


	UDP 25826 from monitored client to the Arbiter/Receiver Collectd module






Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>
    LogLevel info
    NotifyLevel WARNING
</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>
    Host "10.133.63.17"
    Host "10.133.63.19"
    Port 123
    ReverseLookups false
    IncludeUnitID true
</Plugin>

<Plugin df>
    IgnoreSelected false
    ReportByDevice false
    # Also including the reserved space
    ReportReserved true
    # Free/Used Inodes
    ReportInodes true
</Plugin>

<Plugin processes>
    Process "shinken-poller.py"
    Process "cron"
#    Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>
    Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>
    <Node "graphite_server_1">
        Host "10.133.63.13"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
    <Node "graphite_server_2">
        Host "10.133.63.14"
        Port "2003"
        Prefix ""
        Postfix ".collectd"
        Protocol "tcp"
        LogSendErrors true
    </Node>
</Plugin>

######################################################################
#  Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER










Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_MSSQL_SOPHOS_INSTANCES





	type:	Comma separated string list


	description:	MSSQL Instances for Sophos. Default : SOPHOS (only one element)








_PROCESS_SOPHOS_MIN_WARN





	type:	integer


	description:	Min number of Sophos processes, warning threshold








_PROCESS_SOPHOS_MIN_CRIT





	type:	integer


	description:	Min number of Sophos processes, critical threshold










Triggers

This is the list of triggers used in the pack :


	windows_collectd_service.trig

	windows_collectd_processes.trig
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sfl-windows-sophos-mssql


Dependencies


Shinken Modules




Plugins


check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp





or

/usr/lib64/nagios/plugins/check_dhcp





The plugin permissions should be:

-rwsr-xr-x root root check_dhcp





If not, you can fix it with


sudo chown root: /usr/lib/nagios/plugins/check_dhcp
sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp







Network

This pack will create services which need the following protocol :


	UDP 67 and 68 from Poller to monitored client








Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_DOMAINPASSWORD





	type:	string


	description:	domain password








_MSSQLUSER





	type:	string


	description:	MSSQL user








_MSSQLPASSWORD





	type:	string


	description:	MSSQL password








_INFECTED_SERVERS_WARN





	type:	integer


	description:	warning threshold for infected servers count








_INFECTED_SERVERS_CRIT





	type:	integer


	description:	critical threshold for infected servers count
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sfl-windows-system-collectd


Dependencies


Shinken Modules

This pack will create services which need the following modules :


	Arbiter/Receiver : mod-collectd



Here an example of a arbiter-collectd module config file:




Plugins

This pack will create services which need the following plugins :




Network

This pack will create services which need the following protocol :


	UDP 25826 from monitored client to the Arbiter/Receiver Collectd module






Collectd

Here an example of a collectd config file:






Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)




How to use it


Settings

This is the list of settings which can be redefined in the host definition


_LOAD_WARN





	type:	3 comma-separated integer


	description:	Load warning threshold (ie: 7,6,5)








_LOAD_CRIT





	type:	3 comma-separated integer”,


	description:	Load critical threshold (ie: 10,9,8)”








_PROCESS_CRON_MIN_WARN





	type:	integer


	description:	Min number of cron processs, warning threshold








_PROCESS_RSYSLOGD_MIN_WARN





	type:	integer


	description:	Min number of rsyslog processs, warning threshold








_PROCESS_RSYSLOGD_MIN_CRIT





	type:	integer


	description:	Min number of rsyslog processs, critical threshold








_PROCESS_OSSEC_MIN_WARN





	type:	integer


	description:	Min number of ossec processs, warning threshold








_PROCESS_OSSEC_MIN_CRIT





	type:	integer


	description:	Min number of ossec processs, critical threshold










Triggers

This is the list of triggers used in the pack :


	windows_collectd_counter.trig

	windows_collectd_counter_multiple.trig

	windows_collectd_cpu.trig

	windows_collectd_df.trig

	windows_collectd_disk.trig

	windows_collectd_interface.trig

	windows_collectd_memory.trig

	windows_collectd_memory-pagefile.trig

	windows-collectd_process.trig

	windows-collectd_processes.trig

	windows-collectd_service.trig

	windows-collectd_users.trig
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